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Part 1 – Speedy Beginnings

For many documents, we simply start from scratch. However, if you often create the same types of documents (e.g., letters, reports, syllabi, memos, grade sheets, newsletters, and so forth), there are a number of “speedier” ways to begin your work:

· Templates

· Interactive Templates

· Macros

· AutoText

· AutoSummarize

Part 1 of this handout offers visual explanations of each method and tips on when each method is most appropriate.  In general, however, here are some rough guidelines:

1. If you want a document that is pre-formatted with consistent styles (such as a newsletter that you publish periodically), use a template. You can use pre-existing templates (that come with the program), download templates online (see information below), modify existing templates, or create your own template (by simply saving your document as a template).
2. If you want to have automated and/or interactive features or you want to automate a series of steps you carry out routinely, use a macro. However, another method for automating documents that contain changeable fields (such as an entry that might vary depending on the recipient), you can also create a template that includes form fields (see Interactive Templates).
3. If you simply want to insert text automatically into any document, use AutoText.

4. If you want to generate an executive summary or abstract automatically, use AutoSummarize
Templates (Types)

Word 2002 offers a number of different templates. To access the template directory select File, New. Depending on how many options were selected when your Office 97 program was installed, you may or may not have all the templates described below. Each of the following tabs offers a different grouping of templates:

· General – category you select to create your own templates and where your self-designed templates are stored.

· Letters & Faxes – contains templates for various letter, fax, mailing labels, and envelope styles.

· Memos – contains three different styles of memos as well as a memo wizard.

· Reports – contains three styles of reports.

· Legal Pleadings – contains a legal pleading template.

· Publications – contains templates for a term paper and a thesis as well as a newsletter wizard.

· Other Documents – includes different styles of résumés as well as several other templates if you’ve done a “full” install of Word 97.

· Web Pages – provides templates for creating web pages.

· Online Templates – to download templates related to business, education (they even have templates for multiple choice tests, true/false tests, etc.), finance, marketing, time management, etc., go to: <http://office.microsoft.com/home/default.aspx>
Using a Letter Template

In the following exercise, the contemporary letter template is used to create a professional-looking letter quickly (if you don’t have this particular template, select another template and follow the steps as they apply).

Step-by-Step:

1. Choose File, New.

2. When the panel opens to the right of your workspace, note the Templates heading, and then select “On my computer.”
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After the Templates window opens, click on the Letters & Faxes tab and choose the “Contemporary Letter” template. At the bottom of the dialog box, make sure “Create a new document” is selected rather than “Create a new template.”

4. After a moment, the Contemporary Letter template will appear. If you find it hard to read, increase the “zoom” to 75% or higher.

5. Put in your own return address and put in whatever you like for the company name.  Remember, to add information to a template, you should click on the placeholder (to select it) and just type right over the selected text.

6. Make up a name and address for the inside address.

7. Write a letter to your friend explaining how to use a template. Invite your friend to visit so that he/she can learn how to use a template on the computer.

8. Put in your name and title for the closing.

9. Save the document as [your name] template and print and close it.

Creating Your Own Template 

If you use certain forms or want to create your own letterhead or some other document you’ll use repetitively, a template is an excellent option. When you create a template, it remains in your template directory so that you can use it—unchanged—every time you want to create a new document based on your template.

Step-by-Step:

1. Select File, New.

2. [image: image11.png]Mary Smith
2334 Early Bird Lane
Potsville, Oregon 23005
(414) 555-1221

14 February, 1999

Dear



Under the Templates heading in the right-hand panel that appears, choose On my computer. In the window that opens, make sure that the “Create new template” command is checked rather than “Create new document.”  Otherwise, you’ll create a document (which can be altered) rather than a template (which cannot be altered unless you customize it).

[image: image24.jpg]Field

Please choose a field
Categories

(A

Field names:
CreateDate
Database
Date.
DocProperty
Docvarizble
EditTime.

Eq

Fietlame
Fibize

Filin
GoTobuttan
GrestingLine
Fyperink.

I
IncluckPiture

Description

Calclate the result of an expressian

Fied propeties

Click the button below to et advanced field aptions

Preserye formatting during updates





3. When your document opens, you will create your own letterhead to use for future documents. Select Bold and Center. Increase your font to 14 and choose an attractive font style.

4. Type your name and full address. Press Enter twice and make sure to change the font back to 12, turn off Bold, and change the alignment to Right. Insert the date format (enter the date as a field so that the current date will show whenever you open the template) you’ve just created.

5. Press Enter twice and change the alignment to justified.

6. You now have a letterhead “ready to go” any time you want to create a new document. When you save your document be sure to use the drop-down menu on the Save as Type in the Save As dialog box. You want to change the type to “Document Template” so that the document will be stored as a template. Save the template as [your name] letterhead.
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Note: The “Save as Type” option is picture above; note that “Document Template” has been chosen as the file type.
 Macros - What is a Macro?

A macro is simply a set of stored commands and instructions that you can play back by using the macro command you created.  For example, you could create a macro that opened a new document, added the date, and displayed a form or table that you often use. You could assign a keyboard sequence for this command such as Alt + T (for a table) or Alt + F (for a form).  Then, when you typed the command (such as Alt + T) a new document would open up, the current date would be added, and your table would appear.  

Macros are also handy for repetitive correspondence. For example, a college could create macros for letters of acceptance and letters of rejection. The acceptance letter (or paragraph) could be assigned a command such as Alt + Y (for yes) and a rejection letter could be assigned a command such as Alt + N.  If you try to assign a keyboard command sequence that’s already being used (e.g., CTRL + S is keyboarding sequence already used in Word 97 for saving a document).

In short, macros automate tasks. Although quite complex macros can be created using the programming language built into Word, we will be focusing on creating very basic macros.

When would you choose to create a Macro?

If you only want a document that is quickly available, but that will not require interactive features, a template (described above) will probably suffice. If you have a portion of text you often use in various document, AutoText would be a better choice (this shortcut is described later in this section). If you want to create a form where information may be added without disrupting the integrity of the form itself, a form with form fields would be an intelligent option (this process is not explained in these materials). 

However, if you want to automate a series of tasks, a macro can save time. For example, you could create a letter that contains interactive form fields, and then have the macro automatically open the document, print the document, open up the save menu, and close the document.
Recording a Macro

To create a macro, you need to record the entire sequence manually with the Macro recorder turned on. You can activate the macro recorder by double-clicking on REC on your status bar, or by selecting Tools, Macro, Record New Macro. NOTE: Macros cannot record the actions of your mouse; use keyboard strokes only when you are recording a macro.
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Whether you double-click on the Record button on the status bar or use the command sequence (Tools, Macro, Record New Macro), the following dialog box will open:
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Tip:  If you plan on recording several macros, make a small booklet that shows what each macro does and what command sequence you have assigned it or (trust me!), you will forget.  

Step-by-Step:


1. Close whatever documents you are in so that you have a gray screen.  Either double-click on the REC button or choose, Tools, Macro, Record New Macro.
2. Title your macro “personalletter” (you cannot have any spaces in a macro title. Put in a description and the list the keyboard sequence (Alt + L) in the description box:

3. Next, click on the Keyboard button so that you can assign a keyboard sequence for your macro.

4. If you entered your proposed keyboarding sequence, you will be told if that sequence is already assigned. Don’t overwrite an assigned sequence. Try to use command sequences that are likely to be available such as a combination of Alt + Shift and a letter.  In this case, enter the sequence Alt + L.  You will notice that the sequence is unassigned. Click on Assign and Close.
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5. As soon as you press Close on the Customize Keyboard dialog box, your macro will start being recorded.  You’ll see the following button on your screen:



6. Your macro will record every step you make; however, if you make a few mistakes, just correct them and continue. The macro will play back all your steps but only the final product will be displayed.

7. Click the Open button on your standard toolbar to open a new document.  

8. Before typing your heading, click on Center, Bold, Arial, and 14 for your text formatting.  Then type your name, address, and phone number as you would want it to appear on a personal letter:

Leonard Johnson

2323 Mitchell Boulevard

Mayville, Ohio 20003

(515) 555-1225

9. Press enter a couple of times and then choose Right for your alignment, turn off Bold, and change the font back to 10 or 12.  Then enter the date as a field (so that the current date is displayed each time you open your document [Note: If there is a particular date format you like, select that as the default before recording the macro; otherwise the date format that is entered looks like this: 3/5/98].

10. Press enter twice, change the alignment to left or justified, and type Dear.  Click on Stop on your macro recording toolbutton.  Close your document without saving the changes. To test your document, press Alt + L.  You should see the following document displayed:




11. Now, any time you want to start a letter quickly, you can simply enter the keyboard sequence to play your macro.

12. Save your document as [yourname]letter macro and print it.

Tip: If you should forget the toolbutton or shortcut keys you’ve assigned to your macro, you can locate the macro by selecting Tools, Macros; your macro title should appear in the list.

Creating an Interactive Macro

If you create macros that simply run documents or enter paragraphs, you could probably create a template or use an AutoText entry just as easily. However, when you want to create an interactive document (where you can insert individualized or updated information into the body of the document) a macro is your best solution.

Interactive macros work well for any document that requires unique data input (and thus would not be benefited by mail merge features) and/or is a document where the text or data supplied is conditional. For example, an interactive macro would work well for a grading critique sheet where the text inserted would differ if a student had a strong thesis, typical thesis, or a weak thesis (and conditional macros could also be created for every other criterion of the assignment). Similarly, in the exercise below (a letter to an employee announcing his/her salary increase), the information to be filled in would differ with each employee

In the following exercise you will create a standard letter announcing that the named employee has just received a raise. As the employee’s name, current salary, new salary, and effective date of the raise will change from letter to letter; an AutoText entry or template would be slower and less effective.  

Completed Macro:


Note: In the pictured macro above, notice that some words are highlighted in gray. The gray indicates that these are “fields,” or variables (a changing element).  When you run the macro, the prompts you will enter allow you to type in the updated information in each field. For example, the first prompt you would receive in this letter is “Enter employee’s name.” The macro would then continue to run until it reached the next prompt, “Enter the current salary.”

· Step-by-Step – Part 1 – Assigning a Toolbar Command to your Macro

Note: Word 97/2000 screen captures are used below except when the changes are pronounced enough to warrant using screen captures from Word 2002/2003. In general, the steps are very similar in all four versions of Word.
1. Close any open documents and double-click on Record on your status bar.

2. Name your macro salaryraise (Note: there can be no spaces in a macro title) and click on the Toolbar button (in the Record Macro dialog box):

3. After clicking on the toolbar button, the Customize dialog box will open.  Make sure to select the Commands tab.



Customize Dialog Box

4. Make sure to select the salaryraise command listed under Commands (see Customize window pictured on the next page).
Customize Toolbar Window


5. After the salaryraise macro command has been selected drag it out of the dialog box to the File command.  When the File menu drops down, drag the command to the area just above Exit at the bottom of the file menu.

6. You can now access your salaryraise macro by selecting from the File menu:


File Menu with inserted

 
Macro command:


salaryraise macro command

Important: Do not turn off your Macro recorder; just continue on to Part 2 of the instructions.
· Step-by-Step – Part 2 – Creating your interactive macro

1. Open up a new document.


2. Insert the date as a field (so that the current date will always be displayed).

3. Type “Re:   Salary Review”

4. Press Enter two or three times and then type “Dear” and press the spacebar once.  

5. Select Insert, Field.  From the window that appears select Fill-in.

Field Window:






6. Once the Fill-in field has been selected, the Field prompt window will open. Enter a prompt that is logical and clear. In this case, a prompt such as “Enter employee’s name” would be logical:
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7. A prompt box will open; type in the name of your fictitious employee (Mr. Sam Jones), and then add a comma or double-dash after the name. The name will be entered immediately after “Dear” in the macro you’re creating.
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8. Press Enter twice and type the beginning of the letter’s body: “Due to your work evaluations this past week, we are pleased to report that your salary is being raised from” and press the spacebar.

9. Select Insert, Field. Again, select Fill-in from the field names and type (in quotes) the following prompt:  “Enter current salary.”

10. After entering the fictitious salary in the prompt box ($23,000) and pressing Okay type the word “to.”

11. Press the spacebar again and select Insert, Field.  Again choose the Fill-in command and enter the following prompt: “Enter employee’s new salary” and enter the new salary ($35,000).

12. Type the word “effective” and press the spacebar.  Again, select Insert, Field and the Fill-in command.  Type in the following prompt after FILLIN: “Enter effective date.”  (Make up a date).

13. Start a new paragraph and type the rest of the letter: 


All of the administrators at Shanda Leer wish to congratulate you for your fine work.  Please know that your efforts have been noted.

Sincerely,

Mr. Andrew Norton

President

Shanda Leer, Inc.

14. Stop recording your macro and close the document without saving the changes (the Macro will be saved; you do not select to save the changes because this is not a document, but a macro).

15. Select File and the salaryraise macro command from the menu.  You should be prompted to enter the four fields (name, current salary, new salary, and effective date) at the appropriate points in the letter.

16. Save the document as [yourname]interactive macro and print it.

· Practice

Make a list of at least five different documents or letters where interactive macros would be useful.

 AutoText

Perhaps one of the most useful tools Word offers is AutoText. AutoText is used to insert repetitive sections of text into your current document quickly. Repetitive text might include long addresses, specification lists, closing paragraphs, comments regarding particular errors in a student’s paper, common explanations, charts, or any text you find yourself typing over and over.

Step-by-Step:

To create an AutoText entry you must first select the text:  


In the above example, the text selected for an AutoText entry is a repetitive ending paragraph along with the letter’s closing material (“Sincerely . . . ).   Once the text has been selected, you would choose Insert, AutoText, New and type in a short title for your AutoText entry. The title has to be at least four characters long and should be a logical title (so that it’s easy to remember). 

1. To create your own AutoText entry, type the information from the example above:


2. After you’ve typed the material in Step 1, select the entire text.

3. Select Insert, AutoText, New and give your selection the title “closing” and click “OK.”

                                                 [image: image6.jpg]ord willcreate an AutaText entry
from the current selecton,

Please name your AutoText entry:
closing|

o JCema )




4. Close your document without saving the changes and open up a new document.
5. Type the word “closing” slowly. As soon as you see a “floater” containing your text appears, immediately press Enter and the entire entry will be inserted.

6. An AutoText entry remains until you delete it from your AutoText box. If you forget the title of an entry, you can also insert it by selecting Insert, AutoText, AutoText and looking for the title in the entries given.

The AutoText Dialog Box:






· Further Practice:

Type your complete address or some other repetitive text and make it an AutoText entry.  Test your entry to make sure it works!


Tip: It is helpful to create a document (or booklet) where you list all your AutoText entries (and their one word titles) for easy reference. 
AutoSummarize

AutoSummarize may be one of the least known, but most powerful, of Word’s automated features.  AutoSummarize may be used to generate a summary of a document or to highlight the most important ideas. The AutoSummarize feature can help writers see—by the summary generated whether their thesis is being developed adequately and/or create a summary quickly for use in a report or proposal.  

To use AutoSummarize first open the document you want to summarize and then choose Tools, AutoSummarize. The dialog box gives you various options, e.g., whether you want the document highlighted or summarized, how large or how small you wish the summary to be, and whether you want the summary as a separate document or as part of your original paper. 

AutoSummarize Dialog Box
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Note: Often more transition will be needed to improve the sense of the summary but—other than that—it does a remarkable job of summarizing a document.

As an example, in the abstract generated below a six-page article on Annie Dillard was summarized in into one paragraph:


We are pleased to announce that effective May1, 2004 your current salary of     

Handy Keyboard Shortcuts

General Word 97-2003 Shortcuts for Starting and Managing Documents

[Keyboard shortcuts often save time. Note: To remember these shortcuts (or any of the shortcuts in the other two attachments, create a “Shortcuts” note card and keep it next to your computer)]

1. Open a new document – press Control + N
2. Open an existing document – press Control + O
3. Save a document – press Control + S

4. Print a document – press Control + P

5. Close a document – press Control + W

6. Go to the beginning of a document – press Control + Home

7. Go to the end of a document – press Control + End

8. Go to the beginning of a line – press Home

9. Go to the end of a line – press End

Note:  To open any of the Command Bar Menus (e.g., File, Edit, View, Insert, Format, etc.) press ALT + [the underlined letter of the command].  For example, to open the Insert menu, Press ALT + I, and then the underlined letter of any of the commands within the Insert menu: e.g., to use the keyboard to insert a Picture, press ALT + I, P.  

Selecting text:  If you’ve ever tried to select a large amount of text in a longer document or in, perhaps, an Excel worksheet, you may find it difficult to select the precise amount of text you’d like (often, once you select more than one page, the text moves too quickly to control).  To select text easily, do the following:

1. Position your cursor at the beginning of the text you want to select.

2. Hold down the Shift key.

3. Click at the end of the text you’d like to select (while still holding down the Shift key).  Note: You may also select the text entirely “mouseless” by positioning the cursor at the beginning of the text you want to select, holding down the Shift key, and then extending the selection by using the directional keys.







Note that the keyboard sequence (Alt+L) is unassigned. Click on Assign and Close
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Record Button





Make sure to give your macro a logical name (e.g., not Macro2!).





Use this space to describe what your macro does and to list the keyboard se�quence or toolbar button you’ve assigned. 





You can play your macro by using a keyboard sequence or by assigning a toolbar button.





Use this space to describe what your macro does and to list the keyboard sequence or toolbar button you’ve assigned.
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This prompt box will open every time you run this macro; your prompt will remind you what data you need to enter.





Click here to pause recording.





Click here to stop recording.
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Toolbar button





Selected macro


command





Select “Fill-in” from the field names.





Prompt entered after FILLIN.











As always, we appreciate your patronage. Please contact us if you should require any further assistance. We will send you our updated catalogue as soon as it is shipped.





				Sincerely,











				Mary Mason


				Sales Manager
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If one of the entries were selected, its contents would appear in the Preview window





AutoSummarize provides four options:





To highlight key points;


To insert an executive summary at the beginning of the document;


To create a new document containing just the summary; or


To hide everything but the summary without leaving the original document.











Note the section for Templates in the panel to the right. 








Select “On my computer”





To download templates online, 


select “Templates on the Office 


Online”








Kristi Siegel
Mount Mary College
Spring 2004
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